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ABSTRACT 

This study aims to design a kWh meter monitoring system design using Power Line Carrier 

(PLC) media to monitor electricity consumption in real-time through the existing electricity 

network. This system utilizes an optocoupler sensor to detect kWh meter rotation and convert 

current and voltage information into digital signals that can be processed. Data obtained from 

the optocoupler sensor is then sent via the Arduino Uno module connected to the LAN Shield 

and Power Line Carrier for data transmission. On the receiving side, data is received by the 

Power Line Carrier Receiver and transferred to the computer via the LAN Shield port. The 

program developed uses the Arduino IDE on the Arduino Uno microcontroller and Visual 

Studio on the PC to display the monitoring results in the form of an application. Testing was 

carried out using the PZEM-004T and ACS712 sensors to ensure the accuracy of current and 

voltage measurements, as well as the success of data transmission via PLC media. The test 

results show that the system can transmit electric current data with a 100% success rate in one 

building with a data transfer speed of 9800 baud rate. This system offers advantages in terms 

of cost and time efficiency because it utilizes the existing electricity network as a data 

transmission medium. The main advantages of this system are its ability to perform real-time 

monitoring and easy integration with existing electrical infrastructure. However, the 

measurement results indicate the need for further calibration of the sensor to improve accuracy. 

This study concludes that the use of PLC for kWh meter monitoring is an effective and efficient 

solution in electrical energy monitoring applications. 
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Introduction  

In the era of technological development of the industrial revolution, innovation in machine work 

systems, production management control, and energy consumption management are very 

important to improve company performance and energy efficiency. Communication between 

devices in the production system is one of the important elements that allows companies to 

monitor and analyze relevant data, so that they can increase productivity and energy efficiency. 

However, the application of communication systems in industrial environments often requires 

special cabling installations for data transmission. This can lead to excessive cable usage, 

especially in large and complex buildings. This challenge drives companies to seek more 

efficient and effective solutions in terms of data transmission. 

One solution that can be applied is Power Line Carrier (PLC), a data communication system 

that utilizes the PLN electricity transmission network to transmit data. By using PLC, 

companies can reduce the need for excessive data transmission cables, because data can be sent 

through the existing electricity network. This system works by sending data in high frequency 

form through the electricity transmission line. 

One of the main challenges in using PLC is frequency interference that can come from other 

electrical devices connected in the same network. Therefore, in this study, the author attempts 

to develop a tool that uses a PLC communication system with a star concentrator topology and 
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implements the Cyclic Redundancy Check (CRC) method to ensure data integrity during 

transmission. The tool developed is a kWh-meter that uses the PZEM-004T sensor module. 

This sensor is able to read various electrical parameters such as power (Watt), apparent power 

(VA), RMS voltage (V), and RMS current (A). Data obtained from the sensor will be sent from 

the slave module to the master module using PLC communication. The master module will then 

display the data on the local webserver and perform the necessary data logging. 

In the context of modern industry, the need to monitor and manage production systems and 

energy consumption is becoming increasingly urgent. This is mainly due to the increasing 

complexity and scale of operations, which require efficient and reliable communication systems 

to ensure optimal performance. An effective communication system allows companies to obtain 

accurate and real-time information on various operational parameters, thereby making better 

decisions and increasing the efficiency of production processes. However, one of the significant 

challenges in implementing communication systems is the need for data transmission cable 

installations that are often complex and require a lot of cables. The increasing number of 

communication systems in industrial environments can lead to excessive cable usage, which in 

turn can lead to increased costs and installation complexity. In addition, adjusting cables to the 

area and size of the building also increases cable consumption, which is a particular problem 

for companies with large infrastructure. 

To overcome this problem, Power Line Carrier (PLC) emerged as a potential solution. PLC 

utilizes existing electrical transmission lines to transmit data, which can reduce the need for 

additional cables. However, the use of PLC is not without its challenges. One of the main 

problems is the presence of frequency interference that can affect the quality of data 

communication, especially because there are other electrical devices connected to the same 

network. Therefore, this study aims to develop a tool that can overcome these challenges by 

using PLC technology for data communication. By implementing star concentrator topology 

and Cyclic Redundancy Check (CRC) method, this system is expected to ensure data integrity 

during transmission and reduce the impact of frequency interference. KWh-meter equipped 

with PZEM-004T sensor will be used to measure various electrical parameters and transmit the 

data through PLC system. 

Through this approach, it is expected that companies can utilize PLC communications to 

monitor and manage energy consumption more efficiently, reduce the need for additional 

cables, and minimize installation complexity. This research aims to provide innovative 

solutions that can improve operational efficiency and reduce costs associated with installing 

data communication systems in industrial environments. This study aims to design an efficient 

kWh-meter monitoring system using Power Line Carrier media, which is expected to be an 

alternative solution for companies in optimizing energy consumption and reducing the 

complexity of data cable installation. 

 

Literature Review 

1. Bridge rectifier 

a. Half Wave (rectifier half wave) 

 Series This is rectifier half wave with a functioning low pass filter to smooth ripple voltage 

from rectifier. Because the low pass filter This functioning for to smooth ripple voltage, then 

often called as a smoothing filter. If the series This no burdened, then there’s no is outgoing 

current but condenser filled from transformer until voltage on the capacitor become as big as 

voltage peak from transformer reduced voltage on the diode. 
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b. Full Wave (Rectifier Full Wave) 
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Figure 1. Circuit Rectifier Wave Full 

Function from series This is when positive transformer above, then D1 and D4 are biased come 

back or in condition closed and D3 and D2 will be refracted proceed or in condition open. In 

the situation This current flow from transformer through diode D3 to capacitor. It means in 

matter This voltage marked exit with “+” is connection positive from source Power this. When 

the voltage on the transformer Already turn over and become negative above, then diodes D2 

and D3 will refracted come back or in condition closed, D1 and D4 are biased proceed or in 

condition open, then current flow from transformer through diode D4 to capacitor and exit is 

voltage positive. 

For determine voltage peak after installed diode (rectifier) wave full used formula: 

PRMS xVV 707,0
    

707,0

RMS
P

V
V    

Where: 

V RMS = Average voltage (Volts) 

V p = Voltage peak (Volt) 

c. Capacitor leveler voltage 

In the picture circuit, system rectifier produce current wave one way Still there is credit wave 

back and forth back. In general equipment electronic need source current smooth unidirectional 

(DC) or more even. 

In order to eliminate reminder, wave back and forth come back the often used condenser 

electrolyte as a smoothing filter (Filter) such as following: 

 

Figure 2. Circuit rectifier with Filter 

Additions mark parallel capacitors with burden will give effect more DC pulses smooth. The 

higher capacitor value big will keep load at the time Charging. Speed emptying load capacitor 

depends from the magnitude constant time (T) = RL x C. The following image show series 
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rectifier wave full equipped with capacitor filter. Output from rectifier consists of from voltage 

direction and voltage back and forth come back or called with ripple. 

Series cat Power This use series rectifier with filter C for overcome ripple voltage. For 

determine voltage after installed capacitor as leveler so used formula: 

2

ripple

PDC

V
VV   

Where: 

V DC = DC Voltage (Volt) 

V p   = Voltage peak (Volt) 

V ripple = Ripple voltage (Volts) 

 

2. Optocoupler Sensor 

Optocoupler is component electronics used for transfer signal between two circuits with use 
light as a connecting medium. The term "Optocoupler" comes from from two words, namely " 

opto " which means optics (related with light) and "coupler" which means trigger or connector. 

With Thus, optocoupler is devices that rely on light for connect or trigger signal between two 

parts circuit. 

Optocoupler consists of of two parts main: 

1) Transmitter: This part functioning for send ray light, usually in the form of an LED (Light 

Emitting Diode). This LED light up when signal electricity applied to him, producing light that 

can penetrate the optocoupler separation area. 

2) Receiver: This part on duty for detect light emitted by the transmitter. Receiver usually in the 

form of photodetector like phototransistor, photodiode, or photoreistor. When light from the 

transmitter to the receiver, he will change light the become signal electricity that can processed 

more carry on. 

Function The main optocoupler is for isolate two parts different circuits, usually with difference 

voltage or potential electricity, while allows signal transfer between both of them. This is very 

useful for protect sensitive part from system from disturbance or possible damage caused by a 

surge voltage or noise from another part of circuit. 

 

Figure 3. Sensor circuit and illustration 

In the application in practice, optocouplers are often used in various system electronics and 

computers for give isolation electricity, reduce interference signal, and connect circuit with 

need high separation, such as in system control automatic and data communication. 
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Research Method 

 

Figure 4. Research Flow Diagram 

In the method study This done a number of stage for to realize implementation system 

watering automatic in plants. Stages the includes: 

1) Introduction 

a) Determination Topic study 

b) Determination objective study 

2) Literature Review 

a) Relevant literature study 

b) Identify research gaps 

3) Methodology Study 

a) Election method research (qualitative, quantitative, or mixture) 

b) Research design and instruments 

4) Data analysis 

a) Data processing 

b) Analysis statistics or qualitative 

5) Drawing Conclusions 

a) Compiling the results study 

 

Results and Discussion 

At the stage this, will the manufacturing process is explained design kWh Meter monitoring 

tool consisting of of two parts main: device hardware and devices software. Every part own 

functions and components that are interrelated support for reach objective efficient and effective 

monitoring system. 

 

1. Device Hard (Hardware) 

a. Power Supply Testing: Power supply is component crucial in this monitoring system, 

because He responsible answer for provide and stabilize voltage required by all 

component tools, including an Arduino board, a ZMPT101B voltage sensor, and an ACS-

712 current sensor. Testing cat Power involving three type source different power:  

1). USB 5V DC Power Supply: Used for give Power direct to the Arduino board via 

the USB port. 

2). 5V DC Power Supply: Provides 5V DC voltage from the connected external adapter 

to the board. 

3). 3.3V DC Power Supply: Voltage This generated by the voltage regulator on the 

Arduino board to fulfil need components that require voltage more low. 
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4). following table show results testing voltage on the monitoring device: 

 

Power Supply Type Expected Voltage (V) Measured Voltage (V) Status 

USB 5V DC 5.0 5.1 OK 

5V DC 5.0 4.9 OK 

3.3V DC 3.3 3.3 OK 

 

   

   

Figure 5. Current Voltage Data Values Electricity 

b. Optocoupler Sensor Testing: Optocoupler sensor is working for isolate signal between series 

gauges and systems microcontroller, so that protect microcontroller from possible disturbances 

happened on the track electricity. Testing This involving inspection can the sensor separate 

signal with good and working in accordance with desired specifications.  

c. Arduino Mega 2560 and LAN Shield circuit: Circuit This Integrate Arduino Mega 2560 with 

LAN Shield to allow communication network. LAN Shield Works for connecting Arduino 

Mega to network local so that data from sensors can be obtained sent and monitored by online. 

d. Arduino Uno and LAN Shield Circuit: Arduino Uno with LAN Shield working similar with 

Arduino Mega, but with more capacity and features simple. Using Arduino Uno allows 

processing data from more sensors small and also connected to network local. 

e. Power Line Carrier Circuit: Power Line Carrier (PLC) circuit is used for transmit data via track 

existing electricity. Testing This ensure that the data can sent with effective through channel 

electricity without experience significant disruption.  

2. Software 

On the device software, design This involving programming on Arduino Mega 2560 and 

Arduino Uno microcontrollers using Arduino IDE. Devices soft This will process the data 

obtained from the optocoupler sensor and send it through Power Line Carrier system. 

a. Programming Microcontroller: Programming done using Arduino IDE to process data 

from optocoupler sensors. Programming code This covers reading data from sensors, data 

processing, and data communication via LAN Shield and Power Line Carrier. 

b. Remote Monitoring View: For distance monitoring display far, the data sent via Power 

Line Carrier will displayed on the local webserver. User can monitor electrical parameters 

like power, voltage and current from distance far through web interface provided. 

With merge device hardware and devices soft in a way effective, design This KWh Meter 

monitoring tool aiming for give efficient solution in monitoring consumption energy and 

minimize complexity installation data cable in the environment industry 
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Figure 6. Arduino Uno and Lan Shield circuit 

Software 

1. Creating an Arduino Uno Program, Optocoupler Sensor 
Programming for Arduino Uno done using Arduino IDE (Integrated Development 

Environment). This IDE make it easier user in write, edit and upload program code to the 

Arduino board. Here is steps and features main in Using Arduino IDE for Creating a program 

involving Arduino Uno and optocoupler sensors: 

a. Getting started with Arduino IDE: To start programming, run the Arduino IDE 

application by double-clicking on the shortcut on the desktop. When you first open 

Arduino IDE, the initial display is the Arduino sketch editor page. This page provides 

an interface for writing and editing program code (sketch) that will be uploaded to the 

Arduino Uno board. 

b. Toolbar and its Functions: The toolbar in the Arduino IDE consists of six buttons with 

the following functions: 

1) Verify: Button This used for inspect error in program code or sketch. If the code no 

contain error, compilation process will change program code becomes code 

machine that can run by the Arduino board. 

2) Upload: Button This send code machine results compilation to the Arduino board. 

This process uploads the program to the board so that can have executed. 

3) New: Button This create a new sketch, which is useful for start project new. 

4) Open: Button This open the sketch that has been created there is possible user for 

continue work previously. 

5) Save: Button This save the sketch in progress done. Save work in a way periodic is 

very important for prevent data loss. 

6) Serial Monitor: Buttons This opens Serial Monitor, which displays data sent and 

received. through serial communication. This is useful for debugging and 

monitoring the data sent from the Arduino board. 

c. Managing Sketches: To create a new sketch, click on the File > New menu in the 

menu bar, as shown in Figure 4.5. To save the sketch, select File > Save and give the 

project file a name in the appropriate directory. This makes it easier to organize the 

files because after compiling, additional files will appear. After giving the file a name, 

click Save. 

d. Board and Port Settings: To ensure that the Arduino IDE can communicate with the 

Arduino Uno board, select the board type and serial port by clicking Tools > Board > 

Arduino Uno and Tools > Port > COM 54 (or the serial port that corresponds to the 

device). 
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Figure 7. Port Channel and Compile Bar 

 

e. Compile and Upload Sketch: After selecting the appropriate board and port, create a 

sketch project in Arduino IDE. After finishing writing the code, compile it by pressing 

the Verify button. If there are no error messages, the project has been successfully 

compiled. Then, press the Upload button to upload the code to the Arduino board. The 

program will be executed on the board, and the data from the optocoupler sensor can be 

processed correctly. 

With steps This is the programming and testing process. voltage and current monitoring system 

based on Arduino microcontroller can done in a way effective. The program code that has been 

compiled and uploaded can see in attachment 1 as reference addition. 

Power Line Carrier (PLC) Circuit 

Power Line Carrier (PLC) Circuit play role crucial in kWh Meter monitoring system with 

facilitate data communication via track transmission existing electricity. Here This is 

explanation Details about functions and configuration from PLC circuit in system This: 

1. PLC Integration in Monitoring System 

a. PLC Connections and Functions 

Power Line Carrier (PLC) is technology that enables data transmission via network electricity 

that has been there is. In the system This, PLC is used for connecting data from the Arduino 

board to a PC or other monitoring systems. The PLC sends data from the connected optocoupler 

rotation sensor. with Arduino to system receiver at a distance through track electricity. 

b. PLC Setup and Configuration 

1). RJ45 LAN Cable Connection: Port for RJ45 LAN cable is used on PLC for connecting 

PLC with Ethernet network. This cable connected to the LAN Shield installed on the 

Arduino Uno board, so that data can be accessed sent from Arduino via track 

electricity. 

2). Data Transfer: PLC converts digital data from Arduino into signal frequency height 

that can transmitted through network electricity, this data Then received by the PLC 

receiver on the side receiver, which is connected to PC or monitoring system. 

3). Data Reception: PLC Receiver on the side recipient change signal frequency tall return 

into digital data that can be read by device recipient, such as a PC. This data Then 

displayed on the monitoring interface. 
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c. Evaluation and Testing 

For ensure PLC system works with well, some step testing done: 

1). PLC Connection Test: Make sure that PLC can connected with Correct to network 

electricity and LAN cable. Connection This must stable for ensure efficient data 

transmission. 

2). Data Delivery Test: Verification that the data from the Arduino board can sent via PLC 

and received with correct by the PLC receiver on the side recipient. 

3). Data Display Test: The data received by the PC must be displayed with correct on the 

monitoring interface. This ensures that the data transmission process from the sensor 

to display on PC running fluent. 

Pin Configuration and Connections 

In the image, the Arduino Uno and LAN Shield pin configurations are used. in PLC design can 

see. Some points important from configuration This includes: 

1). Ethernet Pins: Used for connect LAN Shield to PLC via RJ45 LAN cable. 

2). Power Pin: Provides cat Power for PLC and LAN Shield, ensure that second device 

get required voltage for functioning with Good. 

3). Data Pin: Connect data signal from Arduino to PLC for transmission through track 

electricity. 

Power Line Carrier (PLC) circuit in kWh Meter monitoring system allows efficient data 

transmission through track existing electricity, reducing need cable additional. With proper 

configuration and correct programming, PLC can transmit data from the connected optocoupler 

rotation sensor to the Arduino board to system receiver at a distance far. Evaluation PLC 

performance includes testing connection, data delivery, and data display for ensure system 

functioning with good and giving accurate results,  

Visual Studio Program Creation 

For displaying data from Arduino Uno, author using Visual Studio to make application that 

displays kWh meter monitoring. Here is steps and manufacturing process kWh meter usage 

monitoring program application using Visual Studio: 

 

1. Form Design 

a. Placing Components on a Form: First Step in making application is put components 

needed on the window forms using the tools in the Visual Studio toolbox. Components 

This including elements interface user such as labels, textboxes, and buttons. Arrange the 

layout components in the form to display become neat and functional. 

b. Arrange Properties Components: After put components, set its properties through 

window Properties. Properties This including name, size, displayed text, and more. 

Settings property ensure that component functioning in accordance with need application 

and provide experience optimal user. 

c. Writing Program Code: Program code is written in the window code in accordance with 

events that occur on the component. For example, if There is button to click for start 

monitoring, then you need to write code for handle click events knob This code is 

arranging how application respond interaction users and manage the data received from 

Arduino. 
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2. Design of kWh Calculation Monitor Form 

a. kWh Calculation Monitor form: Form This designed for displays real -time kWh meter 

monitoring. With this monitoring display, technician can monitor kWh value used with 

easy and get information in a way continuously. 

1). Kwh: Components This display number of kWh used in real-time. Usually, this is an 

updated label or textbox in a way periodic with the latest data from Arduino. 

2). Port: Component This shows the serial port in use connected. It helps user know which 

port is active for communication with Arduino. 

3. Creating a Programming Language in Visual Studio 

After arrange property every objects in the form, steps next is write program code for every 

object. This code arranges How application functions and how data from the Arduino is 

processed and displayed. This process involving: 

a. Writing the Event Code: In the window editor Visual Studio code, you must write 

appropriate command with the function of each object you have created. For example, 

writing code for read data from serial port and update kWh display accordingly with the 

data received. 

b. Handle Error: Visual Studio will display dialog box that helps you fix error in code. Make 

sure for adapt order with function object for avoid error. Testing and debugging is 

required for ensure that application walk with good and displays data accurate. 

With follow the steps above, you can make effective kWh meter monitoring application with 

Visual Studio. Application This will allow technician for monitor consumption energy in real-

time and ensure the data displayed is accurate and up-to-date. 

Testing Power Line Carrier (PLC) 

 For knowing Power Line Carrier works with okay then done test data delivery. The data to be 

sent will programmed and entered to the microcontroller IC. The program entered to IC is a 

program for send data in the form of number 123. 

 

 

 

In this program the command syntax Print “123” works for send data in the form of number 

123 to TX section. And displayed on the LCD 16 x2 section on. 
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Electric Current Data Transmission Testing 

This electric current data transmission test is carried out to ensure that the electric current value 

is displayed correctly on both the transmitter and receiver sides. In the transmitter system, the 

ACS712 current sensor is used to detect the electric current flowing through the sensor when 

the electric load is turned on. The ACS712 sensor is installed in series with the electric load to 

monitor the amount of current passing through the circuit. 

When the load is activated, the ACS712 sensor will measure the electric current and send the 

value to one of the ADC ports on the ATMega16 microcontroller. The ADC port functions to 

convert the analog voltage signal from the sensor into digital data that can be processed by the 

microcontroller. This digital data is then sent via the Power Line Carrier (PLC) system to the 

receiver. 

The receiver system is almost identical to the transmitter system, but there are some differences 

in the configuration, especially in terms of receiving data from the current sensor. The test aims 

to ensure that the current value detected by the ACS712 sensor on the transmitter can be 

received and displayed accurately on the receiver side. The results of this test indicate that the 

system is able to send and receive electric current data effectively through the PLC, with the 

current value displayed on both sides according to the measurements made by the sensor. 

In this study, the current data sent from the transmitter to the receiver involves a laptop as a 

load. The ACS712 current sensor on the transmitter measures the current flowing through the 

load and produces a measurement value of 1153 mA. This data is then sent to the receiver using 

a Power Line Carrier (PLC) modem. 

The test results show that after the current data is sent via the PLC modem, the value received 

on the receiver side remains consistent, which is 1153 mA. This indicates that the electric 

current data transmission system via PLC is functioning properly, and the data sent from the 

transmitter can be received accurately by the receiver. In other words, the process of sending 

electric current data using the Power Line Carrier successfully maintains data integrity, 

ensuring that the values measured by the sensor on the transmitter match the data received on 

the receiver. 

 

Figure 8. LCD Electric Current Data Value 

Table 4. Measurement current electricity with using Digital Multimeter and sensors 

Burden 

( Lamp ) watt 

 Measurement results   

ACS12 Multimeter ZMPT101B Multimeter 

100 1615mA 415 mA 235 v 229.5 v 

200 2769mA 815 mA 232 v 226.3 v 

300 3923mA 1215mA 234 v 228.6 v 
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400 4715mA 1615mA 235 v 229.5 v 

From the results measurements listed in Table 4, are visible that mark current obtained from 

the ACS712 sensor and the voltage measured by the ZMPT101B sensor is not in accordance 

with measured data using a digital multimeter. The difference This caused by several factors, 

one of which is is sensitivity tall from the ACS712 sensor and the ZMPT101B sensor to 

disturbance external. 

current sensor and the ZMPT101B voltage sensor have level sensitivity that can cause 

inaccuracy measurement If No calibrated with right. Disturbance electromagnetic, fluctuation 

power, or even interference from other devices can influence results measurements obtained 

from these sensors. Therefore, calibrating the ACS712 and ZMPT101B sensors becomes very 

important for ensure results more measurements accurate and consistent. 

Calibration not yet completed perfect on sensor can cause deviation from mark in fact, which 

results in differences between results sensor measurements and digital multimeters. For 

overcome problem this, steps following can take: 

1) Sensor Calibration: Performing more calibration thorough to the ACS712 and ZMPT101B 

sensors for reduce influence disturbance and ensure accuracy measurement. 

2) Protection to Interference: Using filters or shielding to protect the sensor from disturbance 

electromagnetic which can influence results measurement. 

3) Testing Environment: Doing testing in various condition environment for understand 

influence disturbance and ensure that the sensor is working with Good in various situation. 

With do steps this, it is expected results measurement from the sensor can more approach results 

measurements obtained from a digital multimeter, so increase accuracy and reliability designed 

monitoring system. 

Conclusion 

The use of the ACS712 sensor as a current transducer offers several advantages, including a 

relatively low price, compact size, and good insulation resistance up to three times the 

overcurrent value. This sensor allows for high-efficiency current detection in a small size. 

However, although the ACS712 has various advantages, the accuracy of the electric current 

measurement is still not completely precise. This indicates the need for more in-depth 

calibration or perhaps the use of additional sensors to improve the accuracy of the measurement 

results. 

Meanwhile, the use of Power Line Carrier (PLC) as a data transmission medium also has 

various advantages. One of the main advantages is that PLC utilizes the existing power grid 

(220V, 50Hz-60Hz) as a communication channel, so it does not require the construction of new 

data transmission network infrastructure. This can save time, effort, and costs for installing 

additional communication channels. 

In system testing, the success rate of sending electric current data from transmitter to receiver 

using Power Line Carrier reached 100% in one building with a transfer speed of 9800 baudrate 

(serial communication speed). This shows that PLC can be relied on for effective and efficient 

data communication in a limited environment such as one building. 

The power grid has great potential to be used as a communication medium, not only for sending 

monitoring data but also for other applications. By utilizing existing infrastructure, PLC can be 

an economical and practical solution for various data communication needs. 
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